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1.3 The Provinelal Plan for the Province of Agusan del Norte

INTRODUCTION

1.3,2 Outline of the Report

Fable 1.3.1  List of Collceted Reports and Documends

[ No. it Year __Source AT
L. GENERAL
I. | The Philippine National Devetoprosat Plan
Program Master Planning 1698 NEDA
». |Caraga Regional Master Plan 1993 - 2008 ROC-Rep. 13
3. |Repoit and Recommendation of the President to
the Board of Directors on Propased Loans to the
Republic of the Philippines for the Rural Water
Supply and Saritation Sector Froject May 1956 ADBR
4. |Report and Recommendation of the President 1o
the Board of Directors on a Proposed Loan tathe
Republic of the Phifippines for the Regional
Municipal Development Project Aug. 1995 ADD
5. |Long Term and Medivra Term Sector Devl.
Planning Workshop No. 3 1995 DILG
6. |Phitippine Agenda - A National Agenda for
Sustainable Development for the 21t Century 1997 POSD
7. |Updated Medium-Teom
Philippine Developmaent Plan 1996 - 1998 Dee. 1995 NEDA
& [|water Supply, Sewerage and Sanitation
Master Plan of the Philippines 1988 - 2000 i988 NEDA
9. [Caratogue Produsts and Services 1993 NAMRIA
10. |The Philippines in 1935: Our Fime Has Come June 1595 op
i1, |Austratian Development Corporation with the
Philippines - Philippine Program Profile
{Section C.3) July 1997 LGU
12. [Social Reform Agenda Policy Birectives Social Refonn
Council Scoretariat
L - -SQCIQ-ECONOMIC
1. 1Secio-Feonomic Profile (Agusan det Norte) PEDO ]
2. Butuan City Land Usz Pian CPDO »
1. |Socio-cconomic and Demographic Profile
of Butuan City June-05 CPDO [ ]
2. [DPata Fncoding and Processing and Fopulahion
Projection Workshop No. 2 1994 - 1993 BiH.G
3. |€ensus-Based National and Regional Poputation
Projection Volume 1595 NSO
4. |Report No. 1-P: Population by Proviace, City/
Municipatity and Barangay
Caraga 1995 Census 1995 NSO




Title_

No . . Year o :g(;urte L N
5. |Repont o, 2-2P: Socio Feonamic and
Demographic Characteristics
Agusan 4zl Norte 1993 Census 1998 NSO
6. |Philippine Statistical Yearbook 1997 NSCi
7. |NSO Census by Province, Male, Fermale and
Age Bracket 1695 N3O FOPCEN
8. |Geogreaphic Coding and Urban and Rural
Classification {(Region V3 - Czraga) 1950 NSO POPCEN
9. | [otal Population, Houschold Poputation and
Number of Households by Provinee, City/
Municipality and Barangay 1595 NSO Census
(115 - WATERSQURCE
. |Master Plan Study on Water Resources
Manapement in Republic of the Phuippines Vol. Jan. 1998 NWRB
2. IMaster Plan Stedy on Water Resourees
Marageaiont in Republic of the Philippines Vol B Fan. 1953 NWRB
1. [Phitippine Water Resources Data Voleme It
Stream@low and T ake or River Stage Jan 1980 NWRC
4. |Phtlippine Water Resources Pata Volurne il
Streamfow and 1 ake or River Stage Iune 1991 DEWIH-BRS
5. |Master Plan Study on Water Resourees
Management in the Repubhic of the Phitippines July 1997 NWRB
&. {Topographic Maps 1:250,000 Reprinted in
Agusan def Norte 91,93 and 06 NAMRIA
7. |Rapid Assessmant of Water Supply Sources 1932 RNWRB
Agusan del Norte
8. |Groundwater Resources Investigation Report Unpublished NWRB
Agusan del Norte
9. [Water Resources Summary Data
{Volume I and 2} (970 NWRE
10, edividual Well Inventory 1890 NWREB
Agusan del Sur
11. {Groundwater of the Philippings June 1980 NWRC
12 JLWUA Water District Database 1997 LWUA
t3. |Road Network Map
Agusan del Norte
14, [Well Inventony NWRB
15, |Well inventory 1998 OPWH-DEO
t6. |Well Drilling Record 1993 DPWH-DEO
i’ WATERSUPPLY -
1. JAssessment of the Domestic WS and Sanitation
Sector of Northern Mindznao Volume V Aug. 1996 NEDA
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2. JAssessment of the Domestic Water Supply and
Sanitation Sector of Northern Mindinao Vol 1 Aug. 1996 NFDA L
1. [Technical Assistance to the Republic of the
Philippines for the Waster Supply and Sanitation
Scctor and Study July 1997 Ann
4. |Working Group on Urbanization {(WG/U) of the
Water Supply 20d Sanitation Collaborative
Council {(WSCC) Sept. 1993 WRCC-WGAUY L]
5. |Water Suppy Feastbility Stedy Methodology
Manua! (LWUA-Mala Columbus) 1996 LWLUA
6. |Overview of Water Pricing Policies and Structures
in the ESCAP Region 1996 UN
12. |Central Visayas Water and Sanitation Project 1996 AusAid »n
13, |Report and Recommendation of the President to
Board of Directars an a Proposed Loan 10 the
LWWA in the Republic of the Philippines for the
Small Towns Water Supply Sector Project Scol. 1996 ADR
| ENVIRGNMENTAL SANITATION
1. | Teziner's Training Kits for Sanitation Mar, 19%6 UNDBE/DILG
2. |Ecological Alrernatives in Sanitation Avg. 1997 SiDA =
1. |[The Code Sanitation of the Philippines 1976 DO
L . INSTITUTIONAL
1. |General Primer - Local Government Code of 19 §99] PBILG
2. | Uhe Rarangay and ihe Local Goverament Code 1694 MLG
3. |NEDA Board Resolution No_ 4 (5. 1994) 1994 NEDA
4. Himplementing Rules and Regulations of
NEDA Board Resolution No. 4 (S 1994),
Clause {G) Nov. 1997 NEDA
5. INEDA 8oard Resolution No. §, S 1924 NEDA
6. [NEDA Board Resolution No. §, §-96 1926 NEDA
7. |NEDA Board Resolution No. 5,5-89 1939 NEDA
VIL | - .~ % COMMUNITY DEVELOPMENT ;<
1. |{Comenunity Development Manual DPWH/DILGS
First Water Supply, Sewerage and Sanitation LWUADOH
Sectors Projects (W45}
2. [BWSA Formulation Operations Manual DPWIVDILG! T
Community Developmient Manual LWUA/DOMN
First Water Supply, Sewerage and Sanitation
Sectors Projects (FWASP)
1. |Institution Building for Decetralized Implementation
of Community-Managed Water Supply and
Sanitation Projects BILG
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4. |Institution Building for Pecentralized Imiplemient-
ation of Community-Managed Water Supply
and Sanitation Piojects June 1997 DILG L
5. |Guidebook for Community Manzged WATSAN
Project UNDPPII L]
6. 1A Manual for Training Trainers in Participatory PROWWESS/ L
Techniques 19%0 UNDP
7. |interception Repori for Special Assistance for
Projeuts Sustainabitity for tha Rural Water Supply
1§ Project 1697 SAPS Team L
8 [nterim Repoat for Special Assistance for Projecis
Sustainability for the Pural Water Supply Ui
Project (SAPS) 1997 SAPS Team L
9. [Participatory Action Planning for the Development
of Two PSF Project 1993 Uy
10. {Water 2nd Sanitation for All: A World Priority 1995 {RC International »
Achievements and Challenges Water & Social Center
12, |Community Organizers' Manual, Par | 1950 CSWCD-UPDCH/
DOFE
13. 1A Handbook on Community Development 1275 up n
14, [Achieving Success in Comimunity Water Supply UNDP u
and Sanitation FProjects
5. [Hendbook on Community Organizing for Water DILG -
Sanitation
16. |Dral Final Report for Special Assistance for
Projects Sustainability for the Rural Water Supply
11 Project Feb. 1997 SAPS Team -
17. |A Manual on Community Participation in Water =
Supply and Sanitation (RWSSP)
18. [Achicving Success in Communily Water Supply and
Samitation Projects 1980 WO [ ]
19. |Commuenily Development Manual Nov. 1995 Pic u
YiiL - GENDER
1. {Sourcebock for Gender Issues at the Policics Level
tn the Water and Sanitation Sector Oct 1596 IBRDAWE n.
2. [Gendur tssucs Sourcebook for Water and Sanita-
tion Projects Jan 1995 IBRD/WG L]
3. |Toolkit on Gender in Water and Sanitation
Series No 2 Aug. 1996 UNDP L
1. [Domestic Shallow Wett Water Supphies the Family
Tendpurnp Scenario Feb. 1990 UNDP n
5. |United Natioas Pecade for Women 19761985 =
6. |Gender Mainstreaming NCRFW L]




ADB - Asian Duvelapment Bank

BRC - Burgau of Research and Standards

QRS - Burean of Repional Standard

CEWCD - Colloge of Socio Work and Commiunity Developawent
DCD - Bepaciment of Communiiy Developacat

DEG - Disgia Engincer Office

DILG - Dxpacment of faterior aml Local Government

DO - Departinent of Health

DOFL - Dovalopment Opiicas Phitippines, Ine

DPWH - Deparment of Works and Highways

IBRD - International Bank for Reconstruciioa and Development
165U - Local Gavernment Unit

LWLIA - Local Water Liilities Administration

MDF - Municipat Developrmicnt Fund

NAMRIA - Nationa! Mapping & Resoutce Information Authority
NCRFW - Matigeal Commission in the Role of Filipino Women
KEDIA - Nationat Economic Development Avthority

NSO - Nalional Sutistical Coordination Beard

NSO - Nationa? Sratistics Office

NAWRD - National Water Resource Bureau

NWERC - National Wates Resturce Council

QP - Office of the President

FCSD - Phitippine Counsct for Sustainable Development

PH] - Plukippine [sland

PIC - Projeck kmplementation Consultants

POPCEN - Fopulution Census

PP - Provincial Planning and Development Office

PROWWESS - Promoticn of the Role of Women in Water,
Frvitonmental and Sanitation Sources

ROC - Regional Developracat Counxil

ST - Swadish Ipternational Develepment Covperation Ayeny

UN - United Nations

ERNDP - United Nations D velopaient Project

UP - University of the Philippines

WATSAN - Wales and Sanitation

WEB - World Bank

WHO - World Health Organization

WSCC- WG - Wates Supply & Sanitation Collaborative
Council-Working Graup on Urbanivabon

G- Global

€ - Ceniral Goverament Level

£ - Regional Govermment Eevel

P - Provincial Leved

M - Municipal Level

B - Barangay Level

[(No.} Tde “Sowse  TCGTCTRTPTMIR]
7. |Regional Memorandums Feb. 1997 MLG T L
8. |Philippine Pian for Gender Development 1995-2025 NCRFW o
9. Phitippine Countsy Report on Women Scpt. 1995 NCRFW "
10, A Pvirner on the GAD Foeal Point 1996 NCRFW L
X - FINANCIL - i __
1. JArnual Investment Plans
Agusan det Noue PEDO -
2. |Family tncome and Expenditures Sunvey Vol 1994 NSO o
3. {Family Income and Fxpenditures Survey Vol 11 15994 NSO »
4. |PN.G Memorandum Circalar 96-263 1596 DILG L
5. |Presidential Docree 1914 (MBF) 1934 oP u
6 |leint Ciccular No. 6-87 Aug. 1987 DM L
7. |Agusan del Norie Accomplishment Reponts,
1393-§596 19931996 FPDO a
10. {Statement of Income-
Enpondiures of Municipalitics PPDO L
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PLANNING APPROACH FOR FUTURE SECTOR DEVELOPMENT

Plavning Principles and Data Management

2.

2.6
2.6.t

Planning Principles
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ANNEXT User’s Guide for Computer-Aided Planning

i, INTRODUCTION

The PWA4SP Data Management Usec's Guide explains the procedure of encoding data and

gencrating tables and tigures for the PWA4SP. The Guide consists of (he following sections.

Section 2: hardware and software required to successfully run the PW4SP Data
Management System

. Section 3: the concept of the miccocomputer architecture and an overview of hardwure
configurations

. Section 4: fundamentals to operate the system with internal architecture

’ Section 5: basic concept of sofware aperation

. Section 6: a complete list of data files and worksheets in the PW4SP Data Munagement
System

- Section 7: data linkages

4 Section 8: the procedure of updating the PW4SP

. Section 9: standard report format

2. SYSTEM REQUIREMENTS

The following are the basic requirement to successfully run the PW4SP data IMLN A ezt

Hardware:

Software:;

Computer: 80486 CPU at 66 MHz Operating System: DOS Ver, .6.22
RAM: 8 MB {minimum) Windows Environment: MS-Window Ver 301
Hard Disk: 200 MB (minimum) Spreadsheet: MS-Excel Ver 5.0
Eloppy Drive: 3.5 inch, High Density Word Processing: MS-Word Ver 6.0

3.25 inch, High Density
Mbnitor: VGA Monitoy
Printer: 80 column

{Can handle A4 s'i;e paper}
Mouse: Any brand which supported

by MS-Windows
Miscellaneous: 00 watts Automatic Voltage

Regulater and Surge Protector



MICROCOMPUTER SYSTEM

All computers, whether large or small, basically operate on the same fundamental principles.
The hardware and software of a mainframe computer and a microcomputer have the same

components and fulfill the basic functions necessary to any computer system.

The computer is seen as a powerful tool that can enable us to expand the horizons of our
knowledge. It allows processing of large volume of data or complex pattern of information

that would otherwise be difficult to organize and understand, Moreover, it allows for an

easily manipulation of dala.

There are two major componeats of a microcompuler: the hardware and the software, These

two components complement each other in order to fulfill their basic function.

A microcomputer hardware is made up of several components based on the functions they

perform in the system and how they interact with the other components.

The principal elements of a computer system are:

« Central Processing Unit (CPU)

« Main Memory (RAM) o .

* Secondary Storage Devices (disk, drives, magnetic tapes, etc.)

¢ Input/Cutput Devices {terminals, printers, eic.)
The CPU does the actual computing. It is capable of simple arithmetic and logical
operations, such as addition and data comparison, that are executed al exceedingly high
speed. The powerof a éomputer directly stems from the speed and accuracy with which the
CPU can carry. out computations and move information arcund. The main memory of the
computer is usually referred to as Random Access Memory ot RAM. This part of the
computer contains the ;ﬁrograms and informalioﬁ that are currently being processed by the
CPU. Secondary storage devices, such as magnetic disk, is capable of holding large amount
of data. Programs and data are’ normd!ly stored on these secondary devices and could be
retrieved when needed. They are then loaded into the RAM and executed. The results of the
processing can thea b w'r.ilte‘n iﬁtu the secondary storage device or sent to an output device
such as the monitor or printer. Peripheral devices or Input/Quiput (/O) devices allow the
user to put data into 2 computer or receive output from a compuier. A terminal is a
peripheral that contains both a keyboard for input and a monitor for ouiput. Other

peripherals include printers and plotters.
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The diagram below presents the basic hardware componeat of a microcomputer system,

Central Processing Unit
(CPUY

IYO Terminal I Secondary Slorag
I J

'imdom Access Memory

Keyboard (RAM)

‘.)I Hard Disk
Monitor }-4_
.‘_,,I Floppy Drive
Printer '4._.

Floppy Drive is the most common type secondary storage used in personal computer today.

[t acts as an external drive from which the users insert the flappy disk to store and retrieve
information. The floppy disk Eémes in three sizes: 3.5 iﬁches, 5.25 inches and 8 inches. It is
characterized by thin circular plastic sheets coated with iron oxide so that magnetic pattens
recorded on it can be retained. The surface is s.imilar to a magnretic tape used to record
music. The disk is contained in a square cardboard envelope in which it spins. The 3.5
inches diskette is contained in a hard i:lastic case with a.meta! shutter that ‘protects the

magnetic media. A ﬂbppy disk can store from 80 kilobytes to 1.44 megubytes of data.

Floppy disk system is slower and has less Storage capacity than hard disk system. but jis

lower cost makes it a popular choice for personal computer.

Hard disk is made of magnetic metal, and can cither be removable or non-removable. The
- most common type of hard disk found in personal computer today

disk typically holds from }0 megabyies to 1.5

is non-removable. This

gigabytes of information. Each megabyte is

equivalent to 1,048,576 characters of information, or roughly 1,800 single-spaced typewritten

pages. hence, this is a very efficient way to store large volume of information.

Keyboard is an external device that acts as & primary interface between the human operator

and the computer. The keyboard has 3 basic componznts: the typewriter keybeard which is

composed of alphabet characters: the calculator pad which s composed of numeric

characters; and the function keys which serve as special macro key for various softwares,
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Monitor is the screen or video display peripheral and serves as the main output device on a
personal computer. It is used to display text and graphics information and is available in a
variety of sizes and types. Monitors can be divided into two broad groups: those designed to
display text information; and those designed to display graphics information, such as charts
or picture. Within the graphics group, there are color or monochrome (single color) displays.
A high quality graphic color moniter is capable of showing high resolution pattern and is

recommended for application in MS-Window, Excel, or AutoCAD.

Printer is another common peripheral found in personal computer system, The 2 commen
type of printers are dot matrix and laser printec. The dot matrix printer produces its image by
printing a group of dots that forms the image of a character or symbol. Several methods ace
used to create the pattern of dots. The most common are impact, thermal, and ink-jet

technologies. The laser printer produces its image by means of electrophotogeaph similar to

the principle of photocopy machine.

OPERATING SYSTEM

An operating system is a set of control program that manages the computer's resources and
create a well-defined software enviconment for computer applications. Computer hardware
by itself can perform little useful work. A computer requires a software to be able to
communicate and do useful work. The first layer of software in 2 computer system is the
operating system. This is what starts, or boots up, the machine tielps in pulling itself up by
its own bootstraps and establishes a predetermined set of conditions so that applications can
be run. Whea the computer is turned-on or the reset button is pressed, the control is pass to a
set of control programs found in the ROM, a firmware store in computer chips. These
programs perform several tasks: (l) to check if hardwares are functioning correctly; (2) to
foad a set of control program from the disk to the memory; and (3) to pass. <ontral to a routine
which will accept the user'input. At this point, the opefating system is loaded and the user

can execute an application program such as MS-Windows, MS-Word, or Excel.

An operating system by itself has two levels of functionality. The first level is seen by the
user running the applications and utilizing system commands and utilities. At this level, each
operating system has its own set of command used to accomplish frequently performed tasks
such as copying files, renaming files, and formatting disks. Normally, frequemiy-used
functions are included in the operating system os system commands. The second is a1 the
programnming level.  All operating systemns contzin a set of pre-packaged routine which

performs the “primitive” functions necessary i almost all applications. Such functions, like

2-37



5.1,

sending a character to the screen, reading and wriling information from a disk file, and
accepting input from the keyboard are common to neardy all programs. This level of

fonctionality gives the programmer a sct of standardized routines to perform this task.

Operating systems, such as DOS or UNIX contain many vseful wiilitics and provide a rich set

of funciion, which simplify the programmer’s job writing application and controlling the
hardwares.

SOFTWARE

The operating system alone renders the computer nearly useless, unless the user is capable of
directly communicating to the hardware. In order to use the computer system, a software. is
needed. Various softwares are available for different purposes, such as MS-Word for word

processing, Excel for spreadsheet and Foxpro for programming. -

VMS-WINDOWS

MS-Windows is a popular software that duplicates the function performed by DOS at the
system ievel. Mosl of the commands are represented by descriptive figures called icons.
Navigating around the windows is through a pointing device called mouse. To execute a
command, the user only need to bring the meuse pointer to the desired command described
by the icon and press the right button. The execution starts without typing any single
character in the keyboard, unlike the DOS convention that needs typing a series of characters
comprising the filename. In windows, the computer screen is referred to as the deskiop.
When working, the application and documents must be in the windows. The windows on the
desktop must also be arranged. If an application is left for a while, the windows are shrunk to
an application icon, and still, the application keeps mnning on the background. When an

application is shrunk, the windows place their application icon at the bottom edge of the

desktop until it is again restored to window size.

With windows, several powerful applications can be run simultaneously. For example, -

switching from a word processing application to a spreadsheet. and then to database
application with a few simple moves while quitting one application and restarting another,

can easity be done.




Two Kinds of YWindows

Application windows contain running applications. The name of the application, the

associated document, and the application’s menu bar appear at the top of the application
window. Application windows can be positioned anywhere within the desktop borders.

Document windows appear only with application that can open two or more documents at one
time inside the same workspace. For example, with Windows File Manager, one can open a
nuinber of directories 2t the same time. Each directory appears in a separate document

windaw (called a directory window) in the File Manager workspace.

Parts of a Windows

Each application and some documents the user choose (o work on, open as separate windows.

Every window has some common elements, however, not all windows use all the items.

The elements as illustrated below ace the tools for working with the window and the

application or document within the window.

insartian point
Control-meny box

Window il Minimizz butioa

Maximizz bulto

Titia bar

DAL T T e A T N

IFite Eo1 Seareh Uelp ' — Menu bar
| n
T — Windavw border
= Vertica!
i sceall bar
i
‘ =d_1 \ A Y l'
\- Windaw carnar \ Mousa pointer \- Horiwental scrolf bar

The Controf-mean box located in the upper-left comer of the window ix the most useful
menuy when the wie of a keyboord is prefecred. The Control-pienu comimunds can resize,

move. maximize, minimize and close windows, and switch to Task List,



The rirdde bar shows the name of the application or document. If more than one window is

open, the title bar of the active window has a diffecent color or intensity compared to the

other title bars.

The window title, depending on the type of window it appears, can be the name of an

application and the pame of the document, or a placeholder. In such case, “untitled”

normally appears.

The meru bar lists the available menus. Mast applications have a File menu, an Edit meny,

and a Help menu as well as other menus unique to the application.

The Scroll bar can mave the parts of the document into view when the entire document will
not fit in the window. With the bar, unseen portion of the lists and other information that is

too long to fit in the allotted space can alsa be viewed.

The Maximize and Minimize buttons enlarge the active application window to fill the entire

desktop or shrink the window to an icon. Document windows enlarge just to fill the
application workspace and not the entire desktop. After enlarging the window, the Maximize

button changes to 2 Restore button. Restore bution can be used to return the window 10 ils

previous size,
The Window border is the outside edge of a window. It can lengthen or sharten each side of
the border.

The Window corner can be used to shorten or lengthen two sides of a border at the same time.

The Workspace is where most of the work with an application are done. For example. the

content of the documents appears in the workspace when starting a wordprocessor. Hence,

an application can allow the opening of more than one document window within this
workspace.

The selection cursor shows where the user is in an individua! document. It marks the place
in the text or graphics where the user begins typing or drawing. The arrow-shape mouse

pointer appears if you have a mouse installed. [t is used to indicate items the user wants to

select with mouse.
Starting Windows

Al the DOS prompt, type win and press ENTER.
2-40




r ""

When staring windows, the Program Manager window is automatically opened with tha
Main Group window opening inside it and other window groups represented as group icons
located at the lower edge of the Program Manager window as show in the illustration in

below,

t Eile  Oplians  Yfindaw

2 S 85 p

Flc Menago Pt Hanaco C‘\;ﬁbud NS00
et

Wbt PAF Edfuce ArriMe

311 iue] i:,uI
4 8t 2TE H

Azcerrones Games Srellp Adcke yont

Quitting Windows

Mouse 1. Quit any application that are currently running.
. Click Program Manager’s File meau to open il.
. Click Exit Windows.
The Exit Windows confirmation dialog box appears.
. Click OK ta exit windows.

I~

(WX

o+,

Keyboard I. Quit any application that are currently running.
Press ALT-F to open Program Manager's File Menu.

. Press X (the underlined letter in Exit).
Or use amrow key to move the hightight w Evit Windosw
and the press ENTER.

- The Exit Windows confirmation dizlog box appears.

. Press ENTER to choose QK and exit windows.

]

o

Starting Window Application
To make starting application easy, Window offecs three methods:
Choose a progeun item from 1 group window in Progrum Munager.

Choose a program file from the appropriute directory window in File Manager.

Choose the Run command from the File mienu in Program Manuger or Fite Munager,
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Starting Applications from Program Manager

As long as an application belongs to a group, the easiest way to start is to choose from the

group window. If a document is included with the application, it will be loaded into the

application workspace.

Mouse 1. Open the Program Manager window, if not already open,
and open the group window that contain the application
you want {0 stat.

2. Double-ctick the icon for the apphcatlon

Keyboard I. Open the Program Manager window, if not already open,
and open the group window that contain the application
you want {o start.

2. Use the arrow keys to move the highlight to the icon for
application.

3. Choose Open from the File menv and press ENTER.

Starting Applications from File Manager

You stant an application from File Manager by opening the program file from a directory
window. You can execute an application program file having .COM, EXE, .PIF, or BAT
filename extension. If the application can run in a window environment, the window will

appear in front of any File Manager windows that are open.

Mouse I. Stant File Manager and open the directory window
that contain the program file,
. Double-click the filename.

o

Keyboard I Start File Managec and open the directory window
that contain the program file,

- Use the arrow keys 1o mave the highlight to the icon for
application.

- Choose Open from the File menu and press ENTER,

o

o

Starting Applications with the Run Command

The Run command is a handy way to stant applications that you want to run only occasionally
ot have not vel added to a group. You can open 2 document at the same time you start the
application. Unless the program file is in your cuirent path, you need to know the exact

directory location and name of the program file before you can start the application.

1. Cheose Run from the File menu in Program Manager or File Manager.
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The Run dialog box appears.

. Type the pathname and the exact filename of the program fite, including
the extension if there is one.

3. If you want the application to shrink to an icon as soon as it starts. make

sure the Run Minimized check box contain an X,
. Chaose OK or press ENTER.

I

=9

MS-EXCEL

Excel is a spreadsheet lype of software package that operates under the MS-WINDOWS
operating system. The primary document in Excel is called a workbook. The workbaok is
similar to a ledger that stores information and each workbook is made up of sheets. The
sheet is virtually divided into column and row; the column run harizontally and denoted by an
alphabet starting with A and the row nun vértically and denoted by number starting from 1.
The intersection of columa and row is called cefl. The cell is the basic componeni of

worksheet that accept different data types. The most common data types are character,

number, date, {ogical value ang formula,

Standard Too.lbar

The standard toolbar that normally appears at the top of sceeen helps select cptions. Such
options can open workbook, print and save worksheet, and ask for help. The following is a

list of the individual icons and their respective functions.

Excel’s Stondard Toolbar

Bulton Nome Function
New Warkbook Creates a new workbook
-‘-'E ~
Open Opens a document
Save Saves the acdve workboak
&
Print Prints the aciive warkboaok
@: Prine Preview Shows the active document i print previesy
#=—hd mode




Excel’s Stcndord Toolbar

Button Nome Function
a ":;"’2_
A Speller Checks the speiling of the document
- Cut Cuts dhe selection 1o the Clipboard
- Copy Copies the selection o the Clipboard
@ Paste Places the Clipboard contents at the insertion
: point
Format Painter Copies and pastes formats for celis and objecs
]
12 o)
S Unde Undoes the last action or command
Repeat Repeauws the last action ar command,
thisis the same a5 the redo feature in Word 6
Autodum Insects the SUM funciion and shows sum range

Stares the Funcdon Wizard

.\;

il Yuncizon Wizard
" L ]
g4l Sort Ascending Sorus selecied cows in ascending order
Z|
AY Sort Desceading Sares selected rows in descending order
'r" 1
AN Chart\Wizard Acuvates the ChartWizaed
’ Tex¢ Box [nsects texe or texe hox
‘. E Drawing Turns the drawing toolhar au o off
100% it :
Zoom Conuol  Sets the view of the docuinent

Tip Wizard Turps the TipWizard teolhar oo or off

“ Help

Displavs Help




Excel’s Formahting Toolbar

Bultan MNome Function
Arial |18
2= Font Seus the font for the selecdon
10 i Foni Size Seus the font size for the
. 3 selecuon
jacy
@'} ' Bold Boldfaces the selecton
=t
B3 : . .
et uatic Tualicizes the selection
ﬁ.-v'—m
S Underline Underlines the selecton
== .
== Align Lefc Lefealigns the selaction
= Center Centers the selecdon
e Aliga Right  Right-aligns the selection
ﬁ Center Across Centers the selecion acros's
= Calumns columns
3;**" Currency Changes the setecied eells o
= Sgle . default currency spyle
Percent Changes the selected cells to
Snie dedault percent sole
Comma Changes the sclected cells o
Sole defrult comma sovle
;«tj‘:’n} [nerease Adds one decimat place a
298 Decimal the aumber format
700 Decrease Removes one decimal place
+-0 Oecimal from the aumber foanat
|._:-—: 'i‘_! Borders Enables you to selecea
— border for che sclecaon -
Color Sets the cotor for the

selecuain

Font Colar

Ses the calor foe the selected
faint




Rasic Part of Excel Screen
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MS-Excel Basic Operation Tebs Workshee!

Following the description of the basic operation, the mouse is used as a pointing device

]

instead of a keyboard. The word click means the user must press the left bution of the
mouse; double click means two successive clicks; and enter means the user must press the
Enter key in the keyboard. Basic operation dealt only to the routine necessary to update the
P\V4SP data base,

Creating a New Worksheet

When you enter Excel, it apens up to a new workbook, by default it contain 16 worksheets.
You can use any of the worksheets, Even if there | 15 an open workbook. you can stnll open

another by moving the mouse pointer in the New icon (upper telt of the screen below the

menu bar}. Click on it

Saving the Warkhook

1. Move mouse pointer 1o File menu and click on it to bring the File menu option.

. From the option available. Select Save.

- It the document your saving is new. The Suve Ax drutog box appeur. In the Fife Name
box type the pawie of the wc;rkbook

'..n? o

Later Datain a Celt

1. First select thc cell by moving the mouse pointer und clicking the
right button. This routine place the insertion point in the active cell,
which is highlighted on-screen with border around it
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2. You can start entering the data from your keyboard or numeric keypad.
3. To conflira the input, you can press ENTER or move the mouse pointer
to the Formula bar and click the Check icon.

Egiting Cell Contents

L. Double-click the cell containing the data you want to edit.
To edit in the formula bag, click in the formula bar. In case the formula
bar is not displayed, choose Formula Bar from the View menu located
at the top row of screen.

2. Edit the cell conteats,

3. To confirm the modification made in the cell, click the Check icon in the
formula bar or press ENTER. To cance! edits, click the X icon in the
formula bar or press ESC.

Clearing Cells

I. Select a cell or range of cells that you want to clear.

2. From the Edit menu, choose Clear, and from the option available,
you the choose All, Contents, Formats, or Notes.
Shortcut: Press DEL.

To clear cells by dragging

1. Select a cell or range of cells that you want to clear,

2. Move the mouse pointer in the fill handle (lower right comer),
drag the £ill handle toward the area of cell or range, then the selected
area will become gray. '

3. Release the mouse button.

Copying Cells

l. Select the cells containing the data you want to copy.
2. From the Edit meny, choose Copy.
3. Select the upper-left cell of the paste area.
Beware that any values or formula in the paste area will be replaced.

Undo Command

I. To undo your last command, click the Undo button,
From the Edit menu. choose Undo.

Creating Border around Cell

tioose the Cell menu from Formal menu.

i.C _
2. Choose the side you want put the border, and then choose type of border.
3. Click OK button.

Deleting Rows and Columns

l. Select the row or column
To delete more than one row ar column, extend the sefection to include
all the rows or columns you want to delete,
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2. From the Edit menu, choose delete (Entire rows or column)
3. Chick OK button

Inserting Rows and Columns

1. Select the tow or column

To insert more than one row or column, extend the selection to include
the number of rows or columns you want to insert.

2. From the Edit menu, choose Insert (Entire rows or column)
3. Click OX button,

Selecting a Sheet or Sheets
To select a single sheet, click the sheet tab.
To select two or more sheets
1. Click the sheet taﬁ for the first sheet you wan! to select.

2. If the sheets you want to select are adjacent, hold down the SHIFT key
and click the tab for the last sheet. '

If the sheets you want to select are non-adjacent, hold down the CTRL key
and click the other sheet tabs.

Ungroup Selected Sheets

1. Move the mouse pointer to the sheet tab. Click the left button of the mouse.

2. While the mouse pointer still on the sheet tab, click the right button and
choose the Ungroup Sheets.

Inserting Worksheet

1. Select a sheet or sheets in the workbo{ak.
2. From the Insert menu, choose Worksheet.

The new sheet or sheets will be inserted to the left of the sheet tab you select.

Shortcut: SHIFT+FI1

Deteting Worksheet

1. Select a sheet or sheets in the workbook.

2. Move the mouse pointer to the sheet tab, and click the right button.
3. Choose Delete, and click the OK button.

Moving Warksheet Within the Workbook

I. Select the sheet or sheets you want to move,
2. Drag the selected sheet tab along the row of tabs.
A black wriangle indicates the place where the sheets will be inserted.
All selected sheets will be inserted. '
3. Release the mouse button.
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Altemate Method

1. Select the sheet or sheets you want (o move.
2. From the Edit meny, choose Move or Copy Sheet,

3. In the Before Sheet box, select where you want sheets ta be insented.
4. Click the QX button.

Moving Sheets te Other Workbook

L. Operi the workbooks you want to move sheets fo and from.
2. Select the sheet or sheets you wanl to mave.

3. From the Edit menu, choose Move or Copy Sheet.

4. In the To Book box, select the destination workbook.

5. In the Before Sheet box, select where you want the sheet or sheets inserted.
6. Click OK button.

Altemative Method

1. Open the workbooks you want to move sheets ro and from.
2. From Window ménu, choose Amange and choose horizontal.
In the desktop, two workbooks will open in screen split the workarea horizonsally.
. Select the sheet or sheets you want to move.
4. Hold-down the CTRL key and the right button ‘of the mouse.
A paper icon and black teiangle indicate that you made the move routineg active.

5. Drag the mouse pointer to the other workbook and select where you want
the sheet or sheets inserted.

6. Release the mouse button,

(9]

Copying sheets within a workbook

1. Setect the sheet or sheels you want to copy-
2. Hold down the CTRL key and mouse left button, and then drag the selected

sheet tab along the row of tabs. A black triangle indicates the place where
the copied sheet will be inserted.

3. Release the mouse button and then the key.

Alter_native Method

1. Select the sheet or sheets you want to copy.

2. From the edit menu, choose Move of Copy Sheet.

3. In the Before Sheet box, select where you want the copied sheet inserted.
4, Setect the Create A Copy check box.

5. Click the OK button,

Copying sheets to other workbook

Opcn the workbook you want to copy to and from.

. Select the sheet or sheets you want to copy.

. From the Edit meny, choose Move Or Copy. Sheet.

i the To Book box, setect the destination workbook.

. In the Before Sheet box, select where you want the copied sheet inserted.
. Select the Create A Copy check box.

. Choose the OK Button.

= O e e =
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5.3,

Printing your Work

1. From File menu, choose Page Setp to dlSpIay the Paoc Setup dialog box.
2. On Page Setu p dialog box, their are {our option available

Page 1ab controls page orientation, scalmg, page size, print quality, and
starting page pumber for the selected sheet.

Margin 1ab controls page margins and the header and footer margins, and
center the sheet on the page vectically, hosizontally or both,

Header/Footer tab controls page the headers and footers for the selected sheet.
headers and footers are descnptwe text that print at the top and battom of
every page in your sheet, You can add, delete, edit, {ormat, and position
headers and footers, and view them as they.will print.

Sheet tab specifies which areas of the sheet you want to print; and controls
the print titles, page order, and draft quality. Also controls whether
gridlines, cell notes, and row and column heading pnnl The Sheet tab is
displayed if the active sheet is a worksheet or macro sheet,

3. On the Print What, their are three option available.

Selection option prints only the selected cells in the selected sheets.
\lonadjacent selections are printed on separate pages. Selecting this
overrides any print areas you have defined for the selected sheets using
Print Area option on the Sheet tab of the Page Serup dialog box.

Selected Sheets option prints the area of each of the currently selected sheets,
with each print area starting on a different page. If no print area is defined
on a separate sheet, the entire sheet is printed.

Entire Workbook option prints the entire print area of all sheets in the active
workbook. If a sheet does not have a print area, that entire sheet is printed.

4. On the Copies box, specifies the number of copies 1o print.
5. On the Page Range, their are two option available.

All option print all the pages in the selected sheets.

Page(s) option print the range of pages specified in the From and To boxes.
Page numbers you selected in the From and To boxes affect which cells
‘will be printed, not the numbering of the pages upon which they are
printed. To change the numbering of printed pages, specify a number in
the First Page Number box of the Page tab in the Page Setup dialog box.

6. The user have option to see the appearance of the print by clicking the

Print Preview button.

7. Printer Setup option give the user an option to select among the availzble
printer drivers.
8. Click the OK butten to proceed printing.

MS-WORD

MS-Word is word processing type of software. This is analogous of converting your
computer into 'ty pewriter machine. You have page in which you type characters, you have a
ruler that show whece you are as you type across the page. You have tabs stops and margin

settings. The insertion point moving across the page even acts like the print head moving
across the page.
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MS-Word offer more advance features that you need 1o create from simple to complex type
of document. When you start Word you will notice almost the identical appearance with that
of MS-Excel. Most of the command are reptesented in terms of icon, in the middle of the

workspace were you enter your text and othet object included in your documents.

Siarting Werd

From the MS-Window environment, you can double-click the MS-Word icon in the MS-
Office program group. In some case the MS-Office administrator is avtomatically loaded at
start-up of Windows environment. The MS-Office administrator menu icons ace located in

the upper cight side of the screen, You can stat MS-Word by clicking the icon.
Quiting Word

1. Move mouse pointer to File menu and click. File sub-menu will appear.
2. From the File sub-menu, move mouse pointer to Exit option and click.
The MS-Word environment will nocmally terminate. In some cases, if some active

documents has not yet been save. MS-Word give the user's option to save the
documents.

Standard Toolbar

The standard toolbar which normally shown at the top of screen helps you select the option,
from this toolbar, The user's can open new document, open existing document, print and save
document, and ask'help to farther understand some function or procedure to accomplish
desired task. Using the toolbar speed-up the desire task instead of using the menu {located at

the top of the screen). The following shows the list of standard toolbar icons and their

fuaction.

Standord Toobar lcons

lcon Name Description

New Creates a new file based an (he Normal templace

QOpen ‘ Disp[ays'l.hc Qpcn dih!og box so that you can select an
existing file to open

)@ ()|

Save Saves the curtent document

Print Prines the current docivment

Print Previcw Activates Word's pring preview feares
:7
i Speiling fnidaies aspelling chieck
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Standard Toobar lcons
leon Nome Description '

i - " e e S s e e

'*‘x’
A Cut Cuts selected material 1o the Windows Clipboard
[
- Copy Copies selecied material to the Clipboard

: @, Pasee Pastes material from the Clipboard into your docu-

meng
’@ FormatPainter  Copies the formatding of a selecdon to the texeyou
— specify
1% Undo Undocs the commands you select from the list
1 a——-
e presented
o 3! Redo Redoes the commands you select from the list pre-
i sented
i)
= .
-~ AutoFormat Formats your document automadcally
— InsertAucoText  Inserts an AuteText enuy
Insert Table Inserts a table inie your document

[nsert Excel Insertsan Excel worksheetinto

= Worksheer your document
===
= .

Columns Formats your documenc using columns

5 Draving Opens the drawing application and enables vou 1o
- draw a picture in vour document
':Nr.
- Insect Charg Inserts a chartinto vour document
arad Zoom Conmol  Scales your view of the document by the percentage
— you select
E" Help Activates contexesensitive help

MS-Word Basic Operation
Opening and Existing Doc.umem
I. Click the Open Folder icon (normally second from the left) to bring up the open

dialog box.

2. In the Open Dialog box, select the file you (0 open from File Name combination
box.

3. Click the OK button.
Changing the Format of the Text

I. Click the arrow button to the right of the font box (o bring the list of available font

2. Scroll through the list box by clicking on the scroll bar, and select

| a font by clicking
o it.

3. Begin typing. The text will dppear in the font you just selected,
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Changing the Yont Size

1. Click the arrow bulton to the right of the fonr size box to bring the list of available
size.

2. Scrolt through the list box by chicking on the scrall bar, and select a size by clicking
on it

3. Begin type. The text will appear in the font size you size selected.

Choose a Style

Perform any of the following procedures to change a font style:
+ Click on the button labeled B to set the bold feature on.
You al$o can press Ctrl+B from the keyboard. -
« Click on the button labeled I to set the italic feature on,
You also can press Curl+1 from the keyboard.
« Click on the button labeled U to set the underlined feurure on.
You also can press Ctrl+U from the keyboard.
¢+ Click on the buiton labeled B and I'to set both bold and itelic features
You also can press Ctcl+B followed by Ctel+I from the keyboard.

Setting Special Effects

You can use a variety of special text effects:
e Strikethrough
*  Superscript
¢ Subscript
e Hidden
» Small caps
* Allcaps

To set any of these fearures, use the following procedure:

. Open the Format menu and sefect the Font item.

. If the Fonts tab is not on top, click on it.

. In the Effect group box, select the check box that represent the spacial effect
¥ou want (o turn on.

. Click the OK bution.

. Begin typing. Your text appears with the special effect you selected.

[

W

Sctting the Indentation

I. Open the Formal menu and select the Paragraph item,

2.1f the Indents and spacing tab is not on top. click on it.

3. In the indentation group box, use the Left and Right spin boxes to set the indentation
from the lefi and right margins. Click on the arrow buttons unnil the measurement is
correct, or select the text in the body by highlighting it with the mouse and thea type
exact measurement you waat.

4. To set ficst line or hanging indentation, open the Special drop-down list box by
clicking on its arrow, and select the appropriate item. Use the By spin box to set the
measurement for the fiest ling indentation or the hanging indentation.

5. Click the OK button. Your current paragraph takes on the indentation you just set.
Each subsequent paragraph you create takes on this patiern, unless you reset the
indentacion using the dislog box,
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Setting Line Spacing

1. Open the Format menuy and select the Pacagraph jtem.

2. f the Indents ang Spacing fab is not on top, click onit.

3.Inthe Spacing group box, use the Belore and Af, ter spin boxes 1o set the distance in
points from the Previous paragcaph and from the following paragraph, Click on the
arew buttons until the measurement” is corvect, or select (he text in the box by
highlighting it with the mouse and then type the exact Measurement you want,

4. To set line spacing within the paragraph, open the Line Spacing drop-down list box by
clicking on its amow, and Select the appropriate item. Then use the At spin box 1o set
the measurement for number of lines or distance between lines, whichever is active.

5. Click the OK buton. Your current paragraph takes on the line spacing you just set,

Each subsequent Paragraph you create takes on this pattem, unless you reset the line
spacing using the dialog box.

Copying and Inserting Text
1. Highlight the text by dragging the mouse pointer over the text 1o be selected.

2. Move pointer to Copy icon and click on it
3. Move mouse pointer to the place were you would like the insertion take place.

4. Move mouse pointer to Paste icon and click on it Alternatively, you can press the right

button of the mouse 1o bring the menu option., select the paste by click on ii.

Undoing and Redoing

If you do make a mistake, you can undo it by selecting the Undo option from the Edit menu.
This procedure undoes the Jas| change you made to the document, Word always will add the
name of the operation You are about to undo as the second word of the Undo menu item. If

you cannot undo anything, this option change to Can't Undo and is dimmed.
Overstriking Text

There are times, however, when you want to type over existing text. To switch to this editing

mode, press the Insert key in the keyboard, When YOu type, the characters you type replace

any characters to the left of the insertion point. To tum off the overstrike mode, press the
Insert key again,

Deleting Text

Use mouse pointer to highlight the desire text and press the Del key from the keyboard.

Insert File

}. Move mouse pointer in the location were you would like the insertion take pluce.
2. From the Insert menv, select File oplion,

3. From the File name combination box, select the file you would like to insert.
Click the OK button,
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Creating the Header or Footer

1. From the View menu, choose Header and Footer.
2. The Header and Footer loolbar appear, click the switch between Header

and Footer button. The header and footer areas are enctoszd by a nonprinting
dashed line.

3. Do one or more of the follawing;
Text - You can type the text within the dashed line that surround the header
or footer area.
Page Number - Click the icon.
Cumrent Date - Click the icon.
Current ‘Time - Click the icon.
4. To retum to the document, choose the Close button on the Header and Footer
toolbar, or double-click the main text area

Previewing the Document

1. From the File menu, choose Print Preview.

While in the print preview mode, you can perform the following options.

4} You can print the document by click the Print bution.

b) You can switch the magnifier on and off by clicking on the magnifier button.

c) You can switch to a one page view by clicking the One Page buttan.

d) You can switch to view multiple pages by clicking on the Multiple
Pages Button and dragging across the grid that appears, releasing the
mouse button when you have the multiple-page view you want to use.

e) You can zoom in or out on your documeni by adjusting the zaom
percentage in the Zoom Control drop-down list box.

f} You can switch the view of the ruler on and off by clicking on the
View Ruler buttan.

g) You can squeeze a small amount of text on the fi nal page into the
the outer pages by clicking on the Shrink to Fit button.

h) You can expand the preview screen 1o show only the page, the

. toolbar, and the status bar clicking on the Full Screen button.
) You can exit the preview mode by clicking on the Close button,

Printing your Document

I. From the File menu, choose Print option.

A Print dialog box appear.
2. In the Print Whar drop-down list box. This option enables you to print the
document or several items ancillary to the docoment, such as Summa:y Info,
Annotation, Style, Autotext Entries, and Key Assignments.

3. Use the Copies box to enter the number of copies to priat.

4. Use the Page Runge option to determing how much of the document to print.
You can print All the document, the Cuirrent Page, or selected Puges.

S. Check the Collute Copies check box to linish the hest set of copy before
printing the second copy.

6. When all it set correctly, close all the dialog boxes you have open,
and click OK buttan, the printing process begia.
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